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Resumen

Se ha desarrollado una aplicacién para dispositivos Android que realiza la reconstruccién en
3D mediante la toma de imégenes usando la cdmara incorporada. Se ha implementado la
posibilidad de tomar las fotografias en el instante o cargarlas desde la galeria del dispositivo.
Una vez las imagenes han sido obtenidas, se calcula una nube de puntos a la cual se le puede
aplicar un filtro para descartar puntos erroneos, procediendo posteriormente a una
reconstruccion de la superficie, mostrando en cualquier momento el resultado por pantalla.

Palabras clave: Android, reconstruccion, 3D, opencv, camara, opengl, pcl

Abstract

An application for Android devices has been developed, which performs a 3D reconstruction
using images provided by the integrated camera. The photographs can be obtained by taking the
pictures in the moment or loading them from the gallery. Once the images are loaded, a point
cloud is calculated, which can be filtered to remove erroneous points. Afterwards a
reconstruction of the surface is performed. The results are shown all the time on the screen of
the device.

Keywords: Android, reconstruction, 3D, opencv, camera, opengl, pcl
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1. Introduccion

Hoy en dia el sistema operativo mas utilizado en el mercado de la telefonia movil es
Android. La gran mayoria de estos dispositivos incorporan diversos elementos como
camaras, microfonos o giroscopios. Dado que casi cualquier persona tiene un
dispositivo mévil como los descritos anteriormente, se ha considerado interesante
desarrollar una aplicacién para la reconstrucciéon de una escena en 3D mediante la
toma de fotografias de dicha escena desde diferentes perspectivas utilizando la cAmara
de dichos dispositivos.

1.1 Presentacion del problema

En la actualidad, las técnicas para la obtencion de modelos 3D estan en auge por las
infinitas aplicaciones de estos. Tradicionalmente se han utilizado equipos
especializados para esta tarea, resultando en un alto costo que no todo el mundo puede
afrontar.

Para la reconstruccién mediante Structure from Motion (SfM) lo tinico que es
necesario es una camara de fotografia, la cual cualquier persona lleva encima en forma
de teléfono inteligente. Por lo que el desarrollo de una aplicacién para la plataforma
Android pone a disposiciéon de mucha gente la reconstruccion en 3D de una escena a un
coste muy reducido.

1.2 Motivacién personal

La motivacién inicial fue la posibilidad de trabajar en el campo de la visiéon por
computador ya que parece un tema muy interesante y en el grado no se ha tenido
ninguna asignatura relacionada con ello. También era una buena posibilidad para
consolidar conocimientos en programacion para Android ya que se considera una
habilidad muy 1til y demandada en el mercado laboral.

Una vez realizada la primera reunién con el tutor y conociendo con mayor detalle la

idea fueron surgiendo nuevas motivaciones, como trabajar con OpenCV, una de las
librerias mas utilizadas en este campo.

1.3 Objetivos del proyecto

El objetivo principal de este proyecto es el desarrollo de una aplicaciéon Android que
permite a los usuarios reconstruir una escena en 3D mediante la utilizacién de
fotografias. Aparte de esta descripcion general del proyecto se definieron una seria de
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objetivos primordiales para que la aplicacion fuera lo suficientemente funcional e
interesante. Estos objetivos son:

e Ofrecer la posibilidad de que el usuario haga las fotografias mediante la misma
aplicacion o que pueda elegir utilizar imagenes ya guardadas en el dispositivo.

e Mostrar el resultado, el cual en este caso es representado mediante una nube de puntos
en 3D, por pantalla en la misma aplicacion.

e Permitir el refinamiento del resultado para mejorar el modelo obtenido.

e Posibilitar la reconstruccion de una superficie a partir de la nube de puntos.

e Poder guardar el resultado en el dispositivo.

1.4 Descripcion de la estructura de la memoria

En este apartado se procede a explicar el contenido de cada uno de los principales
bloques de la memoria.

El primer bloque consiste de cada uno de los apartados anteriores formando la
introduccion.

El segundo bloque se centra en los antecedentes del tema del proyecto y se describiran
las herramientas empleadas para el desarrollo de la aplicaciéon. Es un bloque muy
importante ya que es fundamental tener claro como se quiere realizar el desarrollo de la
aplicacion. El trabajo de investigacion llevado a cabo se expone en este bloque.

En el tercer bloque se detalla el analisis. Se describe detalladamente la solucion
implementada asi como los algoritmos utilizados. Ademas se especifica el diagrama de
clases en UML asi como el diagrama de flujo.

En el cuarto bloque se especifica el disefio del programa. Se expone la metodologia de
desarrollo utilizada asi como el funcionamiento de la aplicacién. También se hace una
puntualizacién en el disefio de la interfaz de usuario ya que es un elemento critico en
los dispositivos moviles.

En quinto bloque consiste en mostrar algin ejemplo completo del uso de la aplicaciéon
asi como los resultados intermedios e finales.

En el ultimo bloque se exponen las conclusiones acerca del desarrollo asi como trabajos
futuros posibles en esta area de trabajo.

Finalmente se adjuntan dos apéndices considerados necesarios para complementar el
proyecto. El primero es el manual de usuario, el cual es considerado fundamental para
explicar como se utiliza la aplicacion y para explicar con méas detalle todas las posibles
opciones que son posibles ajustar para mejorar o refinar los resultados. El segundo
apéndice explica el proceso para la instalacion y configuracion del entorno de
desarrollo ya que se trata de un proceso bastante complejo y que ha requerido mucho
tiempo y esfuerzo.
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2. Antecedentes

Para la realizacion de este proyecto se han estudiado con antelacion una serie de
herramientas para su correcta utilizacion. Se ha intentado escoger aquellas con un uso
simple, buen rendimiento y con mas comunidad detrés. A continuacién se expondran
las tecnologias escogidas asi como el estado actual de estas en el mundo moévil.

2.1 Herramientas empleadas

Aqui se enumeran las herramientas mas importantes utilizadas en el proyecto.

2.1.1 Eclipse ADT

Eclipse es una plataforma de

software compuesto por un ‘
conjunto de herramientas de | —
programacion de codigo abierto '

multiplataforma, también Tlustracion 1 - Logo Eclipse

conocido como IDE (Integrated

development environment). Eclipse fue desarrollado originalmente por IBM como
sucesor de su familia de herramientas para VisualAge. Hoy en dia es desarrollado por la
Fundicién Eclipse, una organizacién independiente sin 4nimo de lucro que fomenta
una comunidad de cédigo abierto.

Para extender sus capacidades para funcionar bajo Android se desarroll6 un
complemento llamada ADT. Esta combinacion de software fue durante afios la solucion
oficial y recomendada para el desarrollo de software en Android. A dia de hoy, el
soporte oficial hacia eclipse por parte de Android ha terminado, y se utiliza una nueva
plataforma llamada Android Studio. Por desgracia, este ultimo ain no esta
completamente desarrollado y algunas funcionalidades atin se encuentran en estado
beta, como por ejemplo, el soporte NDK. Unas lineas mas abajo se explicara con mas
detalle en que consiste el NDK, pero por ahora es suficiente saber que en el proyecto se
le da un uso intenso y por lo tanto Android Studio fue descartado por ain no tener este
funcionamiento a la par con Eclipse.

Aunque Eclipse ya no sea soportado oficialmente, aiin posee muchas funciones
excelentes para permitir el desarrollo de proyectos en Android. Entre ellos destacan la
facil inclusion de librerias, el potente depurador o su soporte para la utilizacion del
NDK.
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2.1.2 Android

Android es un sistema operativo basado en el
nucleo Unix. Fue disefiado principalmente para
dispositivos méviles con pantalla téctil, como
teléfonos inteligentes, tablets o tabléfonos; y
también para relojes inteligentes, televisores y
automoéviles. Inicialmente fue desarrollado por

Android Inc., empresa que Google respaldd Cl n 3 Q O | 3
econdémicamente y mas tarde compro.

Iustracion 2 - Logo Android

Una de sus mas grandes ventajas es que es un sistema libre y multiplataforma. Android
utiliza el lenguaje de programacion Java, pero en vez de utilizar las maquinas virtuales
de Java utiliza una especificamente desarrollada para este sistema operativo llamada
Dalvik. La cual utiliza un bytecode diferente, optimizado especialmente para funcionar
con muy poca memoria, por lo que es ideal para dispositivos moviles.

Arquitectura Android

Applications
Application
Framework
Core (Google)
Libraries Dalvik VM Java
Libraries
Linux 2.6.x
(Kernel)

Tlustracion 3 - Arquitectura Android
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Cabe destacar que el sistema Android estd en una constante evolucién, lanzandose
nuevas versiones cada afio donde muchas veces se cambian completamente algunas
funciones dificultando el soporte para todas las versiones. Por lo que probablemente el
codigo desarrollado en este proyecto quedara obsoleto en poco tiempo.

Para el desarrollo de aplicaciones se utiliza el SDK de Android, el cual incluye un
conjunto de herramientas de desarrollo, un simulador de teléfono y documentacion. El
SDK viene incluido en el complemento ADT de Eclipse descrito anteriormente.

Una aplicacion desarrollada para Android estd normalmente compuesta por
actividades. El concepto de actividad en Android representa una unidad de interacci6on
con el usuario, es lo que coloquialmente se llama pantalla de la aplicacion. Cada
actividad ha de tener una vista asociada, que sera utilizada como interfaz de usuario.
Son las actividades las que realmente controlan el ciclo de vida de la aplicacién, dado
que el usuario no cambia de aplicacién, sino de actividad. El sistema mantiene una pila
con las actividades previamente visualizadas, de forma que el usuario puede regresar a
la actividad anterior pulsando la tecla “retorno”.

Una caracteristica importante, y poco usual, es que la destruccién de un proceso no es
controlada directamente por la aplicacion, sino que es el sistema el que determina
cuando destruir el proceso. Lo hace basandose en el conocimiento que tiene de las
partes de la aplicacion que estan en ejecucion, en la importancia de dichas partes para
el usuario y en cuanta memoria disponible hay en un determinado momento.

Si tras eliminar el proceso de una aplicacion, el usuario vuelve a ella, se crea de nuevo el
proceso, pero se habra perdido el estado que tenia esa aplicacion. En estos casos, sera
responsabilidad del programador almacenar el estado de las actividades, si queremos
que cuando sean reiniciadas conserven su estado.

Una actividad en Android puede estar en unos de estos cuatro estados:

Activa (Running): La actividad esta encima de la pila, lo que quiere decir que
es visible y tiene el foco.

Visible (Paused): La actividad es visible pero no tiene el foco. Se alcanza este
estado cuando pasa a actividad otra actividad con alguna parte transparente o
que no ocupa toda la pantalla.

Parada (Stopped): Cuando la actividad no es visible.

Destruida (Destroyed): Cuando la actividad termina al invocarse el método
finish(), o es destruida por el sistema.

13 ‘v
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Cada vez que una actividad cambia de estado se van a generar eventos que podran ser
capturados por ciertos métodos de la actividad. A continuacidon se muestra un esquema
que ilustra los métodos que capturan estos eventos.

Se crea la actividad

onBesume [} ———

v

Activa

— Visible —
|

onStop () onRestart ()}

v

— Parada —
1

onDestroy()

v

—®  Destruida

Tlustracion 4 - Ciclo de vida de Android

onCreate(Bundle): Se llama en la creacion de la actividad.
onStart():Indica que la actividad esta a punto ser mostrada al usuario.
onResume(): Se llama cuando la actividad va a comenzar a interactuar con el usuario.

onPause(): Indica que la actividad est4 a punto de ser lanzada a segundo plano,
normalmente porque otra actividad es lanzada.

onStop(): La actividad ya no va a ser visible para el usuario. Si hay poca memoria,
cabe la posibilidad de que la actividad sea destruida.

onRestart(): Indica que la actividad va a volver a ser representada después de haber
pasado por onStop().

onDestroy(): Se llama antes de que la actividad sea totalmente destruida. Si existe
una falta de memoria es posible que la actividad sea destruida sin llamar este método.

“f .



2.1.3 Android NDK

El Android NDK (Native Development Kit) permite a los desarrolladores reutilizar
codigo escrito en C/C++ introduciéndolo a las aplicacion a través de JNI (Java Native
Interface). El NDK hace que la ejecucion de las aplicaciones sea en cierto modo mas
rapida, ya que pasara a ejecutarse directamente en el procesador y no es interpretado
por una maquina virtual.

El NDK puede ser ttil y beneficioso para ciertos tipos de aplicaciones, pero también
trae consigo una desventaja bastante importante: la complejidad. Las aplicaciones que
suelen utilizar el NDK son aquellas que haran un uso intenso de la CPU o quieran
utilizar librerias escritas en C/C++. Como en este proyecto se hace un uso intenso de la
CPU mediante los algoritmos de SfM, ademés de utilizar librerias escritas en C++, no
cabe duda que es una buena decision emplear el NDK.

Una de las dificultades que se han presentado en el desarrollo de este proyecto ha sido
hacer funcionar correctamente el NDK, en el Anexo II se describe el proceso

detalladamente.
—eep
INI C/Co+
‘_

Java Native Interface (JNI) es un mecanismo que nos permite interactuar con
aplicaciones nativas desde un programa escrito en Java. Las aplicaciones nativas son
bibliotecas o funciones escritas en lenguajes como C, C++ y ensamblador para un
sistema operativo donde se ejecuta la JVM. La interfaz es bidireccional, permite la
comunicacién de Java con las aplicaciones nativas y viceversa.

IHustracién 5 - Esquema NDK

Cuando Java llama a funciones implementadas en co6digo nativo se habla de llamar a
métodos nativos. Los métodos nativos se implementan por separado en archivos .c o
.cpp, por los cuales se generara una biblioteca de enlace dinamico.

Una biblioteca de enlace dinAmico es un fichero con cédigo ejecutable el cual se carga
en tiempo de ejecucion bajo demanda de un programa por parte del SO. Aportan una
gran ventaja con respecto al aprovechamiento de la memoria del sistema, dado que
gran parte del codigo ejecutable puede encontrarse en bibliotecas, pudiendo asi ser
compartido entre distintas aplicaciones.

Para conseguir dicha libreria dindmica se utiliza un archivo llamado Android.mk donde
al igual que en los archivos makefile de Unix se especifica la manera de compilar los
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archivos nativos. La libreria es compilada con una herramienta llamada JAVAH
proporcionada en el SDK de Android. El resultado de dicha compilacion es un archivo
de cabecera que contiene la declaraciéon de las funciones nativas que se van a utilizar.
Por ultimo se compila todos los ficheros mediante la herramienta ndk-build
proporcionada en el NDK de Android. Como ya dicho anteriormente, en el ANEXO II
se encuentra una descripcion detallada de este proceso.

2.1.4 OpenCV

OpenCV es una biblioteca libre de vision artificial
originalmente desarrollada por Intel para proporcionar un
entorno de desarrollo facil y altamente eficiente. Desde que
apareci6 su primera version, se ha utilizado en infinidad de
aplicaciones. Desde sistemas de seguridad con deteccion de
movimiento, hasta aplicaciones de control de procesos donde
se requiere reconocimiento de objetos. Esto se debe a que su
publicacién se da bajo licencia BSD, que permite que sea Opencv
usada libremente para propositos comerciales y de

investigacion. Tustracién 6 - Logo
OpenCV

Existen diferentes versiones para lenguajes como Java o

Python. Aunque existe una version para Android llamada OpenCV4Android se ha
tomado la decision de utilizar la libreria nativa escrita en C++ para obtener un
resultado lo més eficiente posible, ademas facilitar la reutilizacién de c6digo. Como ya
se ha explicado en el apartado anterior, se utiliza el NDK para que esto sea posible.

En el proyecto se utiliza OpenCV para analizar las fotografias y a partir de ellas obtener
los puntos caracteristicos y calcular la nube de puntos que representa el modelo 3D.

2.1.5 Point Cloud Library

Point Cloud Library (PCL) es una libreria libre para el
procesamiento de imagenes y nubes de puntos. También .
cuenta con una licencia BSD la cual le permite ser usado
libremente para uso comercial o de investigaciéon. Es una
libreria escrita en C++ la cual en este proyecto se utiliza
para aplicar un filtro estadistico a la nube de puntos
resultante proporcionada por OpenCV. También es la
encargada de aplicar las funciones para llevar a cabo la
reconstruccion de la superficie del modelo 3D mediante el

algoritmo Poisson. Ilustracioén 7 - Logo PCL
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2.1.6 OpenGL

OpenGL (Open Graphics

Library) es una

especificacion estandar que

define una API

multilenguaje y p e n

multiplataforma para "
escribir aplicaciones que

produzcan graficos 2Dy 3D. pusiracion 8 - Logo OpenGL ES
OpenGL ES (OpenGL for

Embedded Systems) es una variante simplificada disenada para dispositivos
integrados tales como teléfonos moviles, PDAs y consolas de videojuegos. Es
desarrollada por Khronos, un consorcio entre varias empresas de hardware y software
grafico.

A partir de la version 2 de esta especificacion se deja atras la programacion “fija” dando
el salto al uso de Shaders, lo cual minimiza el coste de los subsistemas graficos
programables avanzados.

Existing Fixed Function Pipeline ES2.0 Programmable Pipeline

Ilustracion 9 - Comparacion entre las Pipelines de OpenGL

En este proyecto se emplea parar mostrar al usuario la nube de puntos resultante del
modulo SfM, asi como el modelo 3D final creado con la reconstruccion de la superficie.

2.2 Estado actual

A dia de hoy no existen muchas aplicaciones o programas que realizan la tarea que se
quiere llevar a cabo con este proyecto. Para el entorno de ordenadores de escritorio la
mas conocida es VisualSFM. Si se expande la biisqueda a las plataformas moviles, se
encuentra apenas una aplicaciéon llamada 123D Catch, creada por Adobe.

Esta aplicacion permite tomar fotos a un modelo, las cuales posteriormente son
enviadas a un servidor donde se realiza el proceso de reconstruccion en 3D y envia el
resultado de vuelta al dispositivo. Esta aproximaciéon conlleva una serie de ventajas e
inconvenientes. Por un lado se puede implementar con mas libertad el proceso de
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reconstruccion al no estar limitado al sistema operativo Android. Por otra parte, el
realizar el calculo en un servidor ajeno, hace necesario que el usuario disponga de
conexion a internet en todo momento con el dispositivo. También puede ser
problemético en cuanto a consumo de datos que conlleva esto, ya que las imagenes a
subir a internet pueden llegar a ser de gran tamafo.

Por tanto se ha considerado apropiado realizar todo el proceso en el mismo dispositivo
para ofrecer una alternativa a la aplicaciéon anteriormente mencionada.

3. Analisis

En este apartado se pretende dar diferentes respuestas a los aspectos planificados
previamente a su implementaciéon. Es un apartado muy importante ya que un buen
analisis puede ahorra mucho tiempo de desarrollo.

3.1 Descripcion de la solucién

A continuacién se pretende contestar la pregunta ¢Qué hace la aplicacién? Para
contestar esto, hace falta explicar los conceptos de SfM asi como los algoritmos que
estan presentes en el proceso. Se asume que la cAmara que ha tomado las imagenes es
siempre la misma y, por lo menos al principio de la explicacion del proceso, que se usan
solamente dos imagenes.

Para el método utilizado en este trabajo se ha seguido el capitulo 4 de [13] el cual se
apoya en el trabajo de Hartley y Zisserman expuesto en los capitulos 9 a 12 de su libro

[12].

3.1.1 Conceptos de Structure from Motion

Primeramente cabe destacar la diferencia entre reconstruccion estéreo usando equipos
calibrados y SfM. Mientras que en un equipo estéreo ya se sabe la distancia que hay
entra las diferentes cAmaras, en SfM no se sabe y hay que determinarla. Por lo que las
reconstrucciones con equipos estéreo son mucho mas precisas al no tener error en la
estimacion de la distancia y la rotacién entre las camaras. El primer paso en
implementar un sistema de SfM es encontrar este desplazamiento entre las vistas.

Si se asume que ya sabemos la distancia y la rotacion, el siguiente paso es reconstruir la
geometria de la escena. En vision por computador a esto se le llama triangulacion, y hay
muchas formas de hacerlo. Desgraciadamente la version actual de OpenCV no contiene
una API para realizar la triangulacion, por lo que hay que implementarla a mano.

Después de obtener la geometria 3D de dos imagenes hay que incorporar més vistas en
el modelo para conseguir una reconstruccion mas densa y precisa. En este punto, se
suele hacer una optimizacién de las posiciones de las caAmaras y los puntos 3D mediante
un proceso llamado bundle adjustment (BA). A pesar de que OpenCV contiene un
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método de BA en el moédulo de Image Stitching, éste solamente contempla la rotaciéon
de la vista y no la traslacion, por lo que no sirve en este proyecto. Desgraciadamente no
se ha encontrado un moédulo de BA que funcione en Android y la aplicacion se queda
sin su implementacion. En el apartado posterior de problemas encontrados se expone
con maés detalle dicho caso.

3.1.2 Estimacion del movimiento de la cAmara

Antes que nada, viene bien analizar los datos de entrada y las herramientas que se
disponen. Se tiene a dos iméagenes de una misma escena en una posicién no muy
diferente. En cuanto a herramientas, existen dos objetos mateméaticos que imponen una
serie de restricciones sobre las imagenes, las camaras y la escena. Estos objetos son la
matriz fundamental y la matriz esencial. Son muy parecidas entre si y lo Gnico que los
diferencia es que la matriz esencial asume una camara calibrada, y como este es el caso,
se usa esta ultima. Cabe destacar que se utiliza una calibraciéon de la cAmara estimada,
la cual se refina en el proceso BA. OpenCV solamente nos permite calcular la matriz
fundamental con la funciéon findFundamentalMat, pero es sencillo obtener la esencial a
partir de la fundamental:

E=K *xFx*xK

Donde K es la matriz de la caAmara calibrada, F la matriz fundamental y E la matriz
esencial.

La matriz esencial es una matriz de 3x3, imponiendo una restricciéon entre un punto de
una imagen y un punto de la otra imagen con x’Ex = 0, donde x es un punto en la
primera imagen y X’ es el punto correspondiente en la segunda imagen.

La matriz de calibracion suele definirse de la siguiente manera:

fmx 0 Cx
K= 0 fm, ¢
0 0 1

Donde fm, y fm, son la longitud focal en pixeles y c,y c, son los puntos principales en
el centro de la imagen. Estos valores son desconocidos por lo que se bosquejan unos
valores aproximados que posteriormente se refinan mediante el BA.

Por tanto, si se obtiene la matriz esencial se puede saber la posicion de las camaras y
hacia donde estan mirando. Si se tienen suficientes de estas ecuaciones de restricciones
se puede calcular dicha matriz con relativa facilidad. En teoria con siete de estas
ecuaciones ya se puede obtener la matriz esencial, pero cuantas mas se utilicen, méas
robusto sera el resultado.
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3.1.2.1 Feature Descriptors

A continuacion se explica como se obtienen las ecuaciones para poder calcular la matriz
esencial. Afortunadamente esto se puede hacer de manera bastante sencilla gracias al
extenso sistema de feature-matching incorporado en OpenCV.

La extraccion de features (elementos caracteristicos o singulares) y el matching
(establecimiento de correspondencias) de descriptores son procesos esenciales en el
campo de la vision por computador. En esencia, extraccion de features se refiere a la
seleccidon de puntos de una imagen que hacen un buen feature, asi como el calculo de
un descriptor para cada punto seleccionado. Un descriptor es un vector de nimeros que
describe el entorno de un punto en una imagen. El matching es el proceso de encontrar
un feature de una imagen en otra comparando su descriptor.

En la siguiente imagen se muestra un ejemplo de los features seleccionados por el
algoritmo.

Tlustracion 10 - Ejemplo de seleccion de features

Si se aplica el matching directamente probablemente se obtienen muchos matches
erroneos. Para remediar esto, se aplican una serie de filtros por los que se pasan los
matches y mediante los cuales los erréneos son eliminados.

Un filtro, el cual estd implementado en OpenCV, es el cross-checking o prueba de
bidireccionalidad. Consiste en que un match es considerado valido si un feature de la
primera imagen es seleccionado con uno de la segunda, y el matching reverso también
selecciona el mismo feature de la segunda imagen con el de la primera. Otro filtro que
se emplea en este proyecto es aplicar el hecho de que las dos imagenes son de la misma
escena y tienen un cierto grado de relacion estéreo. Esto se consigue calculando la
matriz fundamental, la cual se explicara mas detalladamente en futuras secciones, y
retiene las parejas de features que corresponden a este calculo con un error pequeno.

Una vez realizado el matching y aplicados los filtros se obtiene lo siguiente:
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Ilustracion 11 - Resultado de aplicar el matching y el filtrado

3.1.2.2 Optical Flow

Una alternativa al proceso de feature-matching es el optical flow. Este método es
parecido al anterior pero se diferencia en que para cada punto o pixel en la imagen A, se
selecciona un pequeno area alrededor de dicho punto y se compara con la misma regiéon
en la imagen B. Esta comparacion utiliza la técnica llamada consistencia de brillo, la
cual se basa en que estas pequenas areas no se diferenciaran mucho entre ambas
imégenes y por tanto la resta del brillo de ambas zonas tiende a ser cercana a o.

Esta técnica presenta varias desventajas como por ejemplo el coste computacional, ya

que se realiza un calculo para cada pixel de cada imagen. Como este proyecto se centra
en un dispositivo movil, se ha optado por centrarse en el feature-matching.

3.1.2.3 Estimacidn de las matrices de la camara

Una vez obtenidos los pares de keypoints o features, se procede al calculo de las
matrices de las cAmaras. Antes que nada, viene bien examinar la estructura de la matriz
que se va a usar.
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Tlustracion 12 - Matriz de la camara

Como se puede observar en la ilustracion anterior, el modelo de camara que se utiliza
estd compuesto por dos componentes, la rotacion y la traslacion. Determina una
ecuacion esencial: x = PX, donde x es un punto 2D en la imagen y X es el punto 3D en
el espacio. Por lo tanto esta matriz proporciona una relacion muy importante entre los
puntos de la imagen y los puntos de la escena.

Después de calcular la matriz fundamental y la matriz esencial, el objetivo es obtener
los componentes de rotacion y traslacion a partir de estas matrices. Existen varias
formas de realizar esto, pero en este proyecto se ha utilizado la descomposicion en
valores singulares o SVD, proporcionada por OpenCV. La rotacion se obtiene con la
siguiente ecuacion:

R =svd.uxW *svd.vt

Donde W es una matriz especial

0 -1 O
W = 1 0 O
0 0 1

Mientras que la traslacion es la segunda columna de la matriz resultante U del SVD.

t = svd.u.col(2)

Después de este proceso se obtiene una de las dos matrices de camara, para conseguir
la segunda matriz hay que asumir que una de las camaras es fija y canonica (no tiene
rotacion ni traslacion), la siguiente matriz representa a esta camara:
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Tlustracion 13 - Matriz de camara inicial

Por lo tanto se puede decir que la matriz de caAmara que se ha recuperado a partir de la
matriz esencial se ha movido en relacion a la fija.

Desafortunadamente esto no es la solucion completa, ya que al realizar la
descomposicién de la rotacion y traslacidon se obtiene cuatro resultados posibles, y
solamente una es la correcta. La matriz correcta serd la que produce los puntos
reconstruidos con un valor en la Z positivo (puntos que se encuentran enfrente de la
camara). La obtencién de la matriz correcta se calculara con el proceso de triangulaciéon
explicado mas adelante.

Es recomendable realizar una comprobacién de que la matriz fundamental sea correcta.
Muchas veces el calculo de esta matriz es erréneo y si se da el caso es inutil realizar la
triangulacion con una matriz errénea. Se puede comprobar si la matriz de rotaciéon es
realmente una matriz de rotacion calculando el determinante, ya que siempre deberia
tener un determinante de 1 6 -1.

3.1.3 Reconstruccion mediante dos imagenes

En esta seccion se explica como utilizar los datos obtenidos anteriormente para obtener
una reconstruccion de la escena. Para conseguir esto, se va a emplear un método lineal
de triangulacion expuesto en [23].

Como se ha visto anteriormente, para cada punto 2D escogido por el algoritmo de
feature-matching (x) y de las matrices de camara (P), se tiene dos ecuaciones x = PX 'y
x' = P'X, donde x y X’ son los keypoints que han hecho matching y X es el punto 3D
representado en ambas imégenes. Reescribiendo estas ecuaciones se puede formular un
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sistema linear el cual puede ser resuelto para el valor de X. Asumiendo que X =
(x,y,z,1)t se crea un sistema linear no homogéneo con la forma AX = B.

Resolviendo este sistema se obtiene una aproximacion de los puntos 3D a partir de los
puntos 2D. En la siguiente imagen se muestra el resultado de realizar la triangulacion a
partir de dos imégenes.

Tlustracion 14 - Triangulacion a partir de dos imagenes. Fuente: [13]

Cabe destacar un problema que se presenta y que hay que tener en cuenta si se quiere
utilizar mas de dos imagenes para la reconstruccion. Este problema es la escala de la
reconstrucciéon. El movimiento que se ha obtenido entre las dos vistas tiene una escala
arbitraria, no es ninguna unidad como centimetros o milimetros, es simplemente una
unidad de escala.

También hay que realizar una manera de medir el error de la reconstruccion para poder
obtener mejores resultados. Primero hay que definir el significado del término
reproyeccion. La reproyeccion es simplemente escoger un punto 3D y volver a
proyectarlo en una imagen, a partir de ahi se calcula la distancia de dénde esta ahora el
punto reproyectado y donde estaba originalmente. Si la distancia es grande significa
que el error es grande y el punto triangulado es erréneo y no se quiere incluir en el
resultado. La medida global sera la media de las distancias de reproyecciéon y nos indica
el rendimiento de la triangulacion en general. Si la media global es alta, puede deberse
a problemas con las matrices de caAmara, y por tanto con el calculo de la matriz esencial
o los features encontrados.
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Ahora que se ha explicado la triangulacion, ya se pueden poner a prueba las matrices
obtenidas en el apartado anterior y seleccionar la matriz que méas valores positivos
tenga en los valores Z de los puntos y desechar las demés matrices.

3.1.4 Reconstrucciéon mediante multiples imagenes

Puede parecer trivial afiadir méas vistas a la reconstruccion, pero no lo es, ya que
solamente se puede conseguir una reconstruccion con la misma escala en todas las
vistas, y como se ha expuesto anteriormente, esto no es asi.

Existen varias formas de conseguir que la escala sea la misma en todas las vistas. Una
es la estimacion de la pose de la cAmara, también conocido como Perspective N-Point
(PNP), donde se intenta estimar la posiciéon de una cdmara mediante los puntos de la
escena ya encontrados. Otro método es encontrar mas puntos y ver como encajan en la
geometria actual de la escena. Dado que en OpenCV se dispone de una funciona para
solucionar el caso PNP llamada solvePnP, se ha decidido tomar esta aproximacion.

El primer paso en la reconstruccion mediante miultiples imagenes en este proyecto
consiste en encontrar una estructura base de la escena. Para esto se comprueban todas
las imagenes entre ellas para encontrar el par que mas puntos triangulados obtenga. A
partir de esta base, se van anadiendo mas vistas hasta que estén todas en el modelo.

A continuacidén se muestra una reconstrucciéon incremental.

Tlustracion 15 - Reconstruccion incremental. Fuente: [13]
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3.1.5 Refinamiento de la reconstruccion

Aunque en este proyecto no esta incluido el paso de Bundle Adjustment (BA) si que
merece la pena dar una pequena explicacion de lo que trata. El BA es un paso de
optimizacion el cual consiste en modelar todos los datos obtenidos de los pasos
anteriores en un tnico modelo. Las posiciones de los puntos asi como las posiciones de
las camaras son optimizadas minimizando el error de reproyeccion. Este proceso suele
basarse en solucionar enormes ecuaciones con miles de pardmetros, por lo que suele
ser un proceso con un alto coste de tiempo computacional. En la siguiente ilustracion se
muestra el efecto de aplicar la optimizacion del BA.

Ilustracion 16 - Bundle Adjustment Fuente: [13]

A pesar de los filtros implementados, hay bastantes puntos erréoneos que hacen
necesario aplicar algin método para mejorar el resultado. Por lo que se ha aplicado un
filtro estadistico presente en la libreria PCL. Dicho filtro se basa en la computacién de
la distribucion de la distancia entre puntos y sus vecinos. Asumiendo que la
distribucion resultante es de caracter gaussiana con media y derivacién estandar, todos
los puntos cuya distancia media este fuera de un intervalo establecido por la media y
desviacion estandar global son desechados, resultado en un resultado mucho mas
refinado. A continuacion se ilustra la aplicacién de dicho filtro.

Tlustracion 17 - Aplicando el filtro estadistico

‘v 26



3.1.6 Reconstruccion de la superficie

Para este ultimo paso de la solucion, se emplea la libreria PCL la cual ofrece una
implementacion del algoritmo de reconstruccion de superficies Poisson.

Este algoritmo utiliza una nube de puntos junto a una estimacién de la normal de la
superficie local de cada punto. Se reconstruye la funcién implicita f con valor o0 en los
puntos P; y donde el gradiente en este punto P; es igual al vector normal N;. Por lo que
el par P; y N;, es una muestra del campo de vector continuo V. La funcion f se obtiene
calculando la integral del campo de vector V. Dado que no todo campo de vector es el
gradiente de una funcion, el problema puede no tener solucion: el requerimiento y
condicién para que un vector de campo sea un gradiente de una funcion f, es que el
rotacional de V tiene que ser cero. En caso de que esta implicaciéon sea imposible de
imponer, es posible realizar la técnica de los minimos cuadrados para minimizar la
diferencia entre V'y el gradiente de f.

A continuacién se muestra una ilustracion después de realizar la reconstruccion de la
superficie aplicada a una nube de puntos filtrada:

Tlustracion 18 - Reconstruccion de una superficie mediante Poisson
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3.2 Descripcion del flujo de la aplicacion

En este apartado se expone como fluye la informacion a través de la aplicacion. El
programa estd dividido en tres grandes bloques, los cuales seran explicados por
separado. A continuacién se ilustra el diagrama de flujo general de la aplicacidn,
exponiendo cada uno de los mdédulos en més detalle posteriormente.

Ejecutar
Aplicacion

Y

Menu principal

Y

Modulo de entrada

JNI

v

Médulo SfM

Modulo OpenGL

Ilustracion 19 - Diagrama de flujo de la aplicacién simplificado

Como se puede observar, a partir del mena principal se tienen los tres modulos,
entrada, SfM y OpenGL. Cabe destacar que el médulo SfM esta rodeado por el wrapper
de Java a C++ llamado JNI. Cada vez que la informacién entre o salga de dicho modulo,
tiene que pasar por la parte JNI para que ambas partes del cddigo puedan comunicarse.
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3.2.1 Modulo de entrada

Ejecutar
Aplicacion

Y

Menu principal

Y

¢ Tomar o
Cargar —= cargar
h imagenes?

Y
Carga de librerias OpenCV

Y

Lanzar proceso de la
galeria de Android

R—

Seleccion de las
imagenes y carga en

Memoria dispositivo

memoria
No
R JNI
Modulo STM
JNI

—

Modulo OpenGL

~—— Tomar

Y

Carga de librerias OpenCV

y

Lanzar proceso de la
camara de OpenCV

Y

Guardar frame actual
en memoria

Ilustracion 20 - Diagrama de flujo del médulo de entrada
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Una vez ejecutada la aplicacion y en el menu principal, se le da al usuario la opciéon de
obtener las imagenes para la reconstruccion de dos maneras: realizar fotografias con el
mismo movil o seleccionar iméagenes ya presentes en la galeria del dispositivo.

En caso de querer cargar las imagenes desde el dispositivo, se crea una ventana con el
contenido de la galeria donde el usuario puede seleccionar multiples fotografias. Para
poder activar la seleccion miiltiple es necesario mantener pulsado durante unos pocos
segundos una imagen. Posteriormente se pueden seleccionar todas las fotografias con el
simple hecho de presionarlas.

Si el usuario prefiere tomar las imagenes en el mismo momento con su dispositivo, se
carga el contexto de OpenCV junto con el médulo de la cAmara. Una vez aqui, el usuario
puede realizar fotografias pulsando la pantalla. En el mena se encuentra una opcion
para indicar que el usuario ha terminado.

Cargadas las imagenes, se envian en forma de matrices al modulo de SfM para iniciar el
proceso de reconstruccion.

3.2.2 Mobdulo SfM

Una vez obtenidos los datos en el mdédulo SfM se procede a encontrar los features y
realizar el matching entre todas las imagenes. Posteriormente se selecciona la mejora
pareja de vistas para crear la reconstruccion base. En caso de no obtener ninguna base
se vuelve al menu principal, ya que si se falla en este paso, existe un problema con las
imégenes seleccionadas y no se puede proceder con la reconstruccion. Si se ha obtenido
una base, se procede a crear la nube de puntos inicial basandose solamente en las dos
fotografias de la base.

A continuacion se selecciona una vista adicional y se comprueba si es una vista valida
para ahadir al modelo base. Si es valida, se procede a triangular la vista actual con las
vistas anteriores afiadiendo el resultado a la nube de puntos actual, si no es valida, se
descarta.
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3.2.3 Modulo OpenGL
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La nube de puntos calculada por el mdédulo SfM es representada en este modulo
mediante OpenGL. Normalmente es recomendado aplicar un filtro para borrar puntos
erroneos y conseguir una nube de puntos méas precisa. De todos modos, es posible
saltarse el paso del filtrado. Si en cambio, se decide aplicar el filtro, se dibuja en
pantalla un ment donde se puede acceder a la configuracion de las opciones del filtro.
Al seleccionar la opciéon de realizar el filtrado, los datos de la nube de puntos son
enviados al JNI donde son convertidos para ser procesados por el algoritmo de filtrado.
El resultado del filtro es devuelto y representado al usuario. Aqui puede darse el caso de
que el resultado obtenido no es el deseado, por lo que se permite volver al estado
anterior al filtrado y reajustar las opciones del filtro.

Una vez se obtiene el resultado esperado, se realiza un ciclo parecido para la
reconstruccion de la superficie. Es posible ajustar los parametros y realizar la
reconstruccion. Si el resultado no es el deseado, se puede volver al estado anterior y
llevar a cabo los reajustes necesarios. Cuando finalmente se obtiene ya el modelo 3D, se
ofrece la opcion de guardar el resultado en la memoria del dispositivo.

3.4 Diagrama de clases

Los diagramas de clases muestran las diferentes clases y las relaciones entre ellas de un
sistema. Son muy tutiles para entender el esquema de la aplicaciéon de manera rapida y
facilita posibles modificaciones futuras.

En la ilustracion més abajo se muestra el diagrama de clases de la aplicacién. Como ya
explicado anteriormente, en Android las clases utilizadas para mostrar informacion por
pantalla son llamadas actividades, siendo hijos de la clase Activity. Dichas clases
utilizan unos métodos bésicos para poder funcionar, Eclipse introduce estos métodos
de manera automatica.

En cada clase se muestra el nombre, seguido de los atributos y los métodos mas
importantes. Se puede observar que muchas de las clases operan de manera
independiente y no hay estructuras complejas de objetos.

33 °



Aplicacidn para la obtencién de un mapa 3D de una escena con un dispositivo Android

Activity
G
A
Main Activity
OnChckListener)
/-_/’
LoadingScreen Cameradctivity
Loadimages - 1 mimages : List<Mat=
mimages : List= Mat=
| onTousch()
onActmvityResult) onptionsitemnSelected()
SFMProcess()
JHI
startSFM{)
filte()
surface_recarstruction])
RichFeatureMatcher MultiCameraDistance OperGLMainActivity
detector : Pir<FeatureDetector= imgpts - vector<KeyPoint>

mGLSurfaceView | TouchGLSuraecView

extractor . Ptr<DescrptorExtractor
mRenderer - OpenGLRencerer

1 1
- CnClickListener()
MatchFeatures() OnlyMatchFeatures() fiterProcess (]
surfacePracess()
1
1
TouchGLSurfaceView
FindCameraMatrices mRenderer - OpenGLRenderer
onTauchEvent()
GetFundamentalidat]) GLS urfaceView
TeatTrisngulation() MultiCameraPnP D
FinaCameraMatrices(y pointcloud_beforeBA - vestor<CloudPaint> .
pointcCloudRGE_beforeBA | veotar<Veoibs CpenGLRenderer
1 | potygen @ Palygon
pointCloud - PentCloud
Triangulation RecoverDepthF rom Images!)
q onDirawF ramel)
EPSILON : fioat
E——— 1
TriangulatePeints() 1
0.1 ) 0.1
PointCloud Poiygon
LOmiman vertexCiata - FloatBuffer wha - int[]
CroudPomnt - siruct colerData - FloatBuffer whbi  in[]
GetalignedPointsFromMatch() render() render()
CloudPomtsToPoints() )

KeyPaintsToFoints()
Points Takeypoints()

Iustraciéon 23 - Diagrama de clases

Y



4. Diseno

En este apartado se pretende explicar detalladamente como la aplicacion realiza las
tareas, evitando todo lo posible la mencion de cédigo ya que muchas veces puede
complicar demasiado la lectura de esta memoria.

4.1 Plataforma software y hardware

En esta seccidn se expondran brevemente las limitaciones de software y hardware que
se han tenido que tener en cuenta en el desarrollo de la funcionalidad de este proyecto.

Esta aplicacion esta disenada para dispositivos moviles usando el sistema operativo
Android. Esto implica una serie de limitaciones como puede ser que el dispositivo
solamente dispone de una tnica camara (en el mismo lado). Lo ideal habria sido
disponer de dos camaras desplazada ligeramente por una distancia conocida. Esto
hubiera facilitado enormemente el desarrollo de la aplicacion asi como conseguir un
resultado mas exacto. En un primer momento se jugo6 con la idea de utilizar el GPS o el
acelerémetro para determinar la distancia y rotacion de la cAmara entre diferentes
fotografias, pero como demostr6 una investigacion mas profunda sobre dichas
caracteristicas, las estimaciones obtenidas no eran lo suficientemente precisas para esta
tarea. Por lo que se tuvo que recurrir al método de Structure from Motion expuesto en
el apartado de anélisis.

Otra limitacién de hardware es la reducida capacidad de proceso de los dispositivos
moviles. Si que es cierto que se ha conseguido un rendimiento impresionante para el
tamafo de dichos aparatos, pero el problema que se trata en este proyecto requiere de
mucha potencia de computo. Esto dio nacimiento a la idea de que se podrian enviar las
imagenes tomadas por el dispositivo a un servidor donde se ejecutara el método de
reconstruccion. Pero debido a que no siempre se dispone de conexion a internet y a la
gran cantidad de datos, que implicaria subir mucha informacién a internet, se decidié
centrarse en realizar todo el proceso en el mismo dispositivo.

A parte de las limitaciones de hardware se tienen las limitaciones de software, que
también han tenido impacto en el diseno de este proyecto. Aunque si que es verdad que
existen muchas librerias soportadas por Android, ya sea directamente en Java o en
C/C++ mediante el NDK, palidece en comparacion a un entorno de escritorio. Uno de
los impactos maés severos que ha tenido esta incompatibilidad de librerias es que no se
ha podido implementar un método de BA para el refinamiento de la reconstruccion 3d.
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4.2 Funcionamiento de la aplicacion

Con la informaci6n establecida en el analisis se realiza el disefio de los componentes de
la aplicacion, para facilitar su posterior implementaciéon. A continuacion se explicara la
forma de funcionar de las diferentes partes del proyecto.

4.2.1 Toma de fotografias

La primera parte es la toma de datos. Como ya se ha indicado anteriormente, esta se
puede conseguir de dos maneras, cargando las imagenes directamente del dispositivo o
utilizando el mo6dulo de la cAmara de OpenCV. Para esta seleccion se han colocado dos
botones en el ment de inicio. Para saber si un boton es presionado en Android se le
asigna un listener al boton mediante el método setOnClickListener(). Una vez el boton
es presionado y el método ejecutado se llama la siguiente actividad mediante la funcion
startActivity().

El primer proceso que se explica es el de la carga de las fotografias. Una vez instanciada
la nueva actividad, se carga el mdédulo OpenCV ya que se requiere una estructura de
datos proporcionada por esta libreria. Esta estructura es Mat, la cual se puede entender
como una matriz donde cada elemento es un pixel de una imagen dada, por lo que
resulta perfecta para el propdsito que se requiere: almacenar una imagen. Para guardar
varias fotografias se utiliza un ArrayList de elementos Mat.

Para cargar multiples imagenes, se llama al método startActivityForResult() con un
Intent que indica que se quiere seleccionar varios elementos del tipo de contenido
PICTURE. Si se ejecuta correctamente se guarda cada imagen en un elemento de la
ArrayList mencionada anteriormente. Una vez terminado esta parte, se ejecuta un
método de manera asincrona, el cual envia la informacién guardada al JNI. Es
importante ejecutar el proceso de reconstrucciéon de forma asincrona para que el hilo
principal de ejecucion no se quede bloqueado. Cuando se ejecuta un método de manera
asincrona, se crea un nuevo hilo para su ejecucion. En el hilo principal se carga una
actividad que muestra una pantalla de carga para informar al usuario que se estan
procesando los datos.

Para cuando el usuario pulsa el boton para realizar las fotografias con el dispositivo se
ejecuta una nueva actividad en la cual se carga OpenCV para hacer uso de su modulo de
camara. Una vez se ha cargado el moédulo de la cAmara de OpenCV, se muestra por
pantalla lo que se observa por la cAmara. Mediante la funcién onTouch() se escucha
cualquier gesto que se realiza en la pantalla. Cuando el usuario toca la pantalla se
guarda la imagen actual en la misma estructura de datos mencionada anteriormente.
Esto se puede repetir hasta que se selecciona la opcion de Done en el menu de la
actividad. El mend también permite cambiar la resolucion de las imagenes capturadas
por la camara.

%



Una vez terminado, al igual que en el método de carga directa del dispositivo, se llama a
la funcién para enviar los datos obtenidos al JNI.

4.2.2 Algoritmos de Structure from Motion

Cabe destacar que esta parte se ha extraido de [13], simplemente se han llevado a cabo
unas pequenas modificaciones para adaptar el codigo al entorno Android. Aun asi, se
explica a continuacion el funcionamiento.

Cuando los datos del apartado anterior son recibidos en el JNI, lo primero que se hace
es convertir la estructura de datos de Java a una de C++. La estructura Mat es la misma
en ambas versiones de OpenCV (java y C++) por lo que solamente se tiene que
convertir el contenedor. La estructura que mas se adapta a las necesidades es el vector,
por lo que el ArrayList de Mat es convertido en un vector de Mat. El siguiente paso es
pasar los datos a una funcion que empieza el proceso de reconstruccion. Aqui es buena
idea aprovecharse de las ventajas que presenta el paso por referencia de C++ para
mantener un uso de memoria moderado.

Para empezar la reconstruccion se instancia un nuevo objeto de tipo MultiCameraPnP,
el cual es un hijo de MultiCameraDistance, por lo que antes que nada se ejecuta el
constructor de esta clase donde se realiza una comprobacién del tipo de las imagenes y
la creacion de variables necesarias para proceder como por ejemplo la matriz de
calibracion de la caAmara. Al no tener la camara calibrada se realiza una aproximacion.

Una vez creado el objeto con éxito, se llama al método que empieza la reconstruccion.
Primeramente se llama al constructor de la clase RichFeatureMatcher donde se realiza
la extraccién y computacién de descriptores de los puntos clave de cada imagen. El
resultado es guardado en un vector de vectores de puntos clave. Posteriormente se
realiza el matching entre todas las vistas, aplicando el filtro de podado mediante la
matriz fundamental. Gracias a la funcion findFundamentalMat() proporcionada por
OpenCV se puede obtener la matriz fundamental con facilidad. Dicha funciéon también
ofrece la posibilidad de obtener un vector el cual indica si el punto tiene o no sentido
estéreo con la matriz calculada, filtrando los puntos probablemente erréneos.

A continuacion se procede a obtener la linea base o lo que es lo mismo, una nube de
puntos 3D inicial a partir de solamente dos imagenes. Para esto hay que ordenar las
parejas de vistas dependiendo de cuantos puntos en comin tienen. Una vez se ha
establecido dicho orden, se prueba a usar la primera pareja. Primero se calcula la
matriz fundamental entre ellos y si resulta no ser buena, se prueba con otra pareja. La
manera de saber si la matriz fundamental es buena o no, se puede determinar, por
ejemplo, por el nimero total de matchings que quedan después de realizar el calculo y
quedarse con los que tienen sentido. También se puede saber si la matriz esencial
resultante es correcta o no calculando el determinante, el cual deberia ser muy préximo
a 0. Realizando el calculo del determinante sobre la matriz de rotaciéon obtenida se
puede saber si es correcta o no, ya que las matrices de rotacion siempre tendran un
determinante préximo a1 o -1.
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En el caso de que la pareja escogida resulte ser buena, se procede a triangular los
puntos entre las imagenes.

Para realizar la triangulacion simplemente hay que solucionar el sistema planteado en
el apartado de analisis para cada punto. OpenCV ofrece un método llamado solve() el
cual permite hacer esto con facilidad. Cabe destacar que los puntos en 2D estan
representados en forma de coordenadas homogéneas (x,y,1). Hay que asegurarse de
que las coordenadas estén normalizadas, lo cual se consigue multiplicaAndolos por la
matriz de calibracion. En cada iteraciéon sobre un punto se calcula el error de
reproyeccion para posteriormente calcular la media y poder desechar puntos mal
triangulados. Todo este proceso se lleva a cabo en el fichero Triangulation.

Como ya indicado en el analisis, para realizar la reconstruccion incremental se utiliza la
funcion solvePnP de OpenCV. Esta funcién intenta solucionar un sistema dado los
puntos que ya se han reconstruido y una nueva camara, por lo que necesita dos vectores
alineados entre los puntos 2D y 3D. Vectores alineados significa que la el elemento en
la posiciéon n de un vector se alinea con el elemento en la misma posiciéon del otro. Por
lo que hace falta encontrar los puntos 2D en los ya triangulados puntos 3D. La forma
mas simple de hacer esto es anadir a cada punto 3D su origen. Por esta razén se ha
utilizado una estructura especial para un punto 3D donde se almacena el mismo punto
y un vector de enteros con los indices (para cada vista) de su origen en 2D. Esta
informacién es necesaria inicializarla cuando se triangula un punto, guardando que
camara ha estado involucrada. Una vez obtenido el resultado de solvePnP y éste sea
aceptable, se puede obtener la nueva matriz estimada de la posicion para la camara y
utilizar nuevamente la triangulacién entre esta y todas las vistas anteriores para
popular la nube de puntos con mas puntos. Todo esto se repite hasta haber iterado
sobre todas las imagenes disponibles.

4.2.3 Representacion de los resultados

Al terminar el proceso de reconstruccién, los datos son devueltos al JNI donde son
convertidos a estructuras de datos del JNI para poder transformarlos a JAVA. En un
principio no se realizaba este paso, y se guardaba el resultado en un fichero en la
memoria fisica del dispositivo, pero por temas de rendimiento se cambi6 finalmente. El
tener los datos en la memoria virtual del dispositivo disminuye enormemente la
velocidad de carga de los mismos, sobre todo a la hora de mostrarlos por pantalla.
Cuando el hilo de la reconstruccién termina, se llama a una nueva actividad llamada
OpenGLMainActivity encargada del proceso de mostrar los resultados por pantalla.
Esta actividad es necesaria para inicializar la actividad que realiza el renderizado de lo
que se mostrara. También incluye los métodos de escucha de los botones del men1, asi
como crea una instancia de la actividad encargada de leer los gestos tactiles que se
producen en la pantalla por el usuario, llamada TouchGLSurfaceView.

Los datos son enviados a la clase OpenGLRenderer en formato de un vector float.

Dependiendo de si se quiere dibujar una nube de puntos o un poligono, cambiara la
forma en que se guarda el contenido. En caso de tratarse de una nube de puntos, los
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tres primeras posiciones tendran asignadas las coordenadas X, Y, Z de la posicion del
primer punto, seguido por su informaciéon de color, representado también por tres
valores, RGB. En cambio si se trata de un poligono, los primeros dos valores del vector
indican la cantidad de vértices que tiene el modelo, y el segundo valor indica el nimero
de caras que componen el modelo. Las siguientes posiciones son las coordenadas de
todos los puntos, seguido de las normales de todos los puntos y finalmente el orden de
utilizar los puntos anteriores para crear las caras de la figura.

A la vez que se extraen estos datos, se obtiene el punto medio de cada modelo
calculando la media entre el valor mas alto y el méas bajo de cada coordenada en cada
eje (X, Y, Z). Esto es necesario para posteriormente poder rotar el objeto sobre si
mismo, consiguiendo una rotacion mucho mas natural e imposibilitando al modelo
salirse del area visible.

Para poder renderizar en OpenGL ES 2.0, hace falta encapsular la informaciéon en
buffers. Estos buffers son enviados directamente a la memoria de la GPU y guardados
ahi, ofreciendo un considerable incremento en el rendimiento. Creados estos buffers se
envia la informacién para que sean representados, mediante GL_POINTS en el caso de
tratarse de una nube de puntos o GL_TRIANGLES en caso de ser un poligono.
También hace falta multiplicar las matrices de modelo, vista y proyeccién para
conseguir el resultado deseado. Aqui es donde entra en juego la clase mencionada
anteriormente de TouchGLSurfaceView, ya que cuando el usuario desliza el dedo por la
pantalla, esos valores son recogidos por esta clase y enviados a la clase de renderizado
modificando la matriz de modelo para representar la rotaciéon correspondiente del
modelo.

En todo momento se exponen una serie de botones en la parte inferior de la pantalla,
para poder seguir con el proceso o configurar lo que se vaya a realizar en el siguiente
paso. Para mostrar el menu del filtro o la reconstruccion de la superficie se llama a otra
actividad para exponer todas las opciones de configuracion. En caso de que se presione
el boton de filtrar o reconstruccion, los datos son enviados nuevamente al JNI para que
se realice la accion correspondiente.

En caso de realizar el filtrado los datos son convertidos a una estructura de datos propia
de la libreria PCL llamada PointCloud<PointXYZRGB>. Una vez realizada esta
conversion se crea un objeto SatisticalOutlierRemoval, al cual se le pasa los datos junto
a los parametros de configuracién para que realice el filtrado. Posteriormente se
extraen los puntos filtrados de la estructura anteriormente mencionada y se guardan en
un vector, devolviendo los datos al m6dulo de representacion.

En la reconstruccion de la superficie los datos viajan de la misma manera que en el
filtrado, aunque la estructura de datos esta vez es ligeramente diferente ya que no
permite una nube de puntos de color, si no, simplemente una nube de puntos. Por lo
tanto la estructura es la siguiente: PointCloud<PointXYZ>. Para aplicar la
reconstrucciéon de poisson, hace falta realizar una estimaciéon de las normales de cada
punto presente en la nube. Esto se realiza con un objeto llamado NormalEstimation, el
cual recibe los parametros de configuracion y los datos. El resultado es una estructura
PointCloud<Normal>, la cual solamente contiene las normales estimadas, por lo que es
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necesario concatenarla con la nube de puntos original. Ahora los datos estan
preparados para ser enviados al objeto de reconstruccién de la superficie llamado
Poisson<PointNormal>. Una vez calculada la superficie, es devuelta en una estructura
PolygonMesh, la cual estd compuesta por los vértices y las caras del modelo. Cabe
destacar que la informaciéon de las normales se ha perdido, por lo que es necesario
recalcularlas para poder representar la figura posteriormente con OpenGL. Extrayendo
los datos de sus respectivas estructuras, los datos son devueltos al JNI y de ahi a la
actividad de OpenGL.

En la clase de renderizado se cuenta con tres variables donde se almacena la nube de
puntos cruda, la nube de puntos filtrada y el poligono final. Esto facilita volver a un
estado previo si no se esta contento con el resultado, evitando tener que recalcular algo
ya obtenido. Mediante el uso de variables booleanas se controla lo que es mostrado por
pantalla en cada momento. Una vez llegado al punto de la reconstruccion completa, es
posible guardar el modelo actual en la memoria fisica del dispositivo pulsando el boton
save.

4.3 Metodologia de desarrollo

La metodologia empleada en este proyecto es el modelo en espiral. Se basa
principalmente en la reducci6on del riesgo asumido y posibilita la mejora y la
introduccion de nuevos elementos durante el desarrollo.

El modelo consiste de una serie de campos, los cuales son recorridos en forma de
espiral hasta alcanzar todos los requerimientos establecidos. Las diferentes etapas
suelen ser las siguientes:

1. Anélisis: Suele ser la primera fase y en ella se establecen detalladamente los
requerimientos de cada objetivo asi como los riesgos y las posibles soluciones.

2. Diseflo: En esta etapa se especifica el disefio de la aplicacion basandose en los
datos obtenidos en la parte del anélisis.

3. Implementacién: Aqui se realiza la implementacién del disefio con codigo.

4. Evaluacion: Esta es una fase vital que muchas veces no es tenida en cuenta lo
suficiente. Aqui se revisa el funcionamiento de lo implementado y se comprueba
que se hayan alcanzado todos los requerimientos establecidos. También sirve
para encontrar problemas que puedan llevar a un cambio en el disefio del
proyecto.
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Ilustracion 24 - Metodologia espiral

4.4 Casos de uso

[ Toma de datos mediante camara |

Realizar fotografia
T
\ Cambio de resolucion

Terminar toma de datos

Tlustracion 25 - Caso de uso Camara

‘ Seleccion de galeria |

Seleccion de imagenes

Terminar toma de datos

Iustracién 26 - Caso de uso galeria

Los casos de uso son una herramienta 1til en el proceso del disefio de una aplicacion
mostrandonos cuando el usuario interacttia con una determinada parte del sistema.
Suelen ser acciones realizadas por el usuario y no por el sistema, realizando una accion
completa en un tiempo corto desde el punto de vista del usuario.
También muestran en cierta medida una funcionalidad, aunque en este caso se refiere a
lo que se espera que la interaccion realice y no a como lo realiza.

A continuacién se mostraran los diferentes casos de usos que se presentan en este
proyecto. Dado que el modulo de SfM no requiere de interacciones, no existe ningin
caso de uso para esta etapa. En modulo de entrada de datos, se puede dar el caso de dos
interacciones diferentes:
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En el médulo de representacion de los resultados existen un total de tres casos posibles,
mostrados a continuacion:

Configurar filtro
/ Saltar filtro
/

e |

Ampliar nube
Aplicar filtro

Superficie reconstruida

Volver a nube de puntos filtrada

Rotar modelo
Ampliar modelo
Guardar modelo

{
/N

Ilustracion 27 - Caso de uso

Ilustracién 28 - Caso de uso nube de puntos
nube de puntos filtrada

Superficie reconstruida

Volver a nube de puntos filtrada

Rotar modelo
Ampliar modelo
Guardar modelo

Tlustracion 29 - Caso de uso superficie
reconstruida

=

Como se puede observar, se ha intentado mantener un bajo nimero de acciones
posibles en cada seccién para crear una aplicacion simple de manejar y no confundir al
usuario.
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5. Resultados

En este apartado se pretende mostrar los resultados obtenidos. Por una parte se va a
realizar una ejecucion completa de la aplicacion desarrollada mostrando paso a paso los
resultados utilizando unas imagenes guardada en la galeria del dispositivo. Por otra
parte se va a mostrar un ejemplo de reconstrucciéon de superficie un poco més completo
usando la herramienta MeshLab. La nube de puntos de la cual se parte en este tltimo
ejemplo, sera la que ha sido calculada por la aplicacion desarrollada.

Si se quiere conocer la parte de toma de fotografia mediante la cAmara incorporada, es
recomendable consultar el ANEXO I presente al final de este documento.

5.1 Ejecucion de un ejemplo

Pulsando el boton correspondiente en el ment principal se abrira la vista mostrando
todas las imagenes disponibles en la galeria.

DYY[Qe

— ScanEye3D ~

Ilustracion 30 - Ejecucion - Gal
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Pulsando sobre una de las iméagenes que se R IR 2 BEK J ® O “4 @ 1318
desean utilizar, se activardA el modo
seleccion muiltiple. En este caso se han [JRSEEST= ETelel o] FETe [ ABRIR

elegido tres fotografias.

Una vez seleccionadas las imaéagenes,
comienza el proceso donde se calcula la
nube de puntos en 3D. Mientras se lleva a
cabo el proceso, se muestra un pantalla de
carga indicando que la aplicacion esta
trabajando.

® % O 4 @ 1:59

ai
>l R,
26 de ene.

LOARDING

Iustracion 31 - Ejecucion - Selecciéon miltiple

Dado que la potencia de procesamiento de
un dispositivo movil es limitada, este
proceso puede tardar bastante tiempo. En
este ejemplo, ejecutandolo en un Nexus 4,
se ha tardado alrededor de un minuto para
las tres imagenes mostradas.

Tlustracion 32 - Ejecucion - Pantalla de carga
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Cuando este proceso finaliza se abre una nueva vista con el resultado calculado. Como
se puede observar, la nube de puntos guarda cierta relacion con el objeto fotografiado.
Desgraciadamente el proceso de obtencion de la nube de puntos no es perfecto y por
tanto la mayoria de las veces existiran muchos puntos erroneos.

FILTER SETTINGS “

< @)

Tlustracion 33 - Ejecucion - Nube de puntos

En el ejemplo se pueden observar estos puntos en los laterales de la figura, por lo que es
buena idea utilizar el filtro implementado para remediar esto. Entrando en la
configuracion del filtro, se procede a probar con los valores por defecto.
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s A ® O ‘4 @139 HYY[H®
ScanEye3D

Filter menu
Amount of neighbours used in %

Threshold used to be considered a good
point

0.1

< O

Iustracion 34 - Ejecuciéon - Ajustes filtro 1 Tlustracion 35 - Ejecucion - Nube filtrada 1
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ScanEye3D

® O ‘4 H13:19

Filter menu
Amount of neighbours used in %

Threshold used to be considered a good
point

0.1

Iustracidén 36 - Ejecucion - Ajustes filtro 2

La mejora obtenida respecto a la primera
vez es poca, por lo que en este caso no era
necesario realizar un reajuste de los
parametros. Procediendo a la
reconstruccion de superficie, se prueba
primeramente con los valores por defecto.

Comparando ambos resultados se aprecia
la mejora que ha supuesto la aplicacion
del filtrado. Aunque la nube de puntos
actual ya es aceptable para proceder a la
reconstruccion de la superficie, se va a
intentar mejorarlo mas ain. Reajustando
los ajustes del filtro como muestra la
imagen, se consigue:

DYY[Q®

SURFACE SETTINGS BACK
< O

Tlustracion 37 - Ejecucion - Nube filtrada 2
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Surface reconstruction menu
Normal search radius

0.1

Poisson depth

1 v

Poisson samples per node

1 v

Ilustracion 38 - Ejecucion - Ilustracion 39 - Ejecucion -
Ajustes superficie 1 Reconstruccion 1

Lo cual no corresponde en absoluto con el objeto inicialmente fotografiado. Por lo tanto
es un buen momento de volver atras y reajustar las opciones del algoritmo.
® O ‘4 @1325
‘ScanEyeaD
Surface reconstruction menu
Normal search radius

Poisson depth

Poisson samples per node

Tlustracion 40 - Ejecucion -
Ajustes superficie 2
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Tlustracion 41 - Ejecucion - Reconstruccion 2

Comparado con el primer resultado es mejor, pero sigue siendo un mal resultado.
Volviendo otra vez y ajustando atin més los parametros:

SYY[e ® O ‘4 @13:23

'ScanEye3D
Surface reconstruction menu
Normal search radius

Poisson depth

Poisson samples per node

Save

Ilustracion 42 - Ejecucion - Ajustes superficie 3
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® % O 4 @ 518 ® % O 4 @ 518

Tlustracion 43 - Ejecucion - Reconstruccion 3-1 Ilustracion 44 - Ejecucion - Reconstruccion 3-2

Lo cual ya parece un resultado mucho mas acertado. Al disponer ya de un modelo
decente, se procede a guardarlo en el dispositivo pulsando el bot6n correspondiente.
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5.2 Reconstruccion de la superficie con Meshlab

Dado que Meshlab ofrece la posibilidad de crear una superficie con textura a partir de
una nube de puntos, se ha considerado interesante utilizar la nube de puntos que se ha
obtenido con la aplicacion y realizar un reconstruccion con Meshlab. A continuacion se
explicara brevemente como se consigue esto y después se expondran los resultados
obtenidos.

Una vez cargado la nube de puntos en Meshlab, el primer paso es calcular las normales.
Para esto hay que dirigirse a:

Filters > Normals, Curvatures and Orientation > Compute normals for
point sets

El segundo paso es reconstruir la superficie, esto se hace en:

Filters > Remeshing, Simplificaction and Reconstruction > Surface
Reconstruction: Poisson

El siguiente paso es conseguir la textura, para ello hay que dirigirse a:

‘ Filters > Texture > Parametrization: Trivial Per-Triangle ‘

Ahora hay que guradar el proyecto en:

‘ File > Save Project ‘

En las opciones de guardado hay que seleccionar “Flags” y “Normal” bajo “Vert” y
“Flags” bajo “Face”.

A continuacion hay que transferir el color a la textura:

Filters > Texture > Transfer Vertex Attributes to Textures

En “Source Mesh” hay que seleccionar la nube de puntos de origen, y habilitar la opciéon
de “Assign Texture”.

Con esto el programa procedera a aplicar la textura a la superficie, en este caso
obteniendo lo siguiente:

Ilustracion 47 - Reconstruccion Ilustracién 46 - Reconstrucciéon Ilustracién 45 - Reconstruccion
MeshLab - 1 MeshLab - 2 MeshLab - 3
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6. Conclusiones

6.1 Problemas encontrados

Durante el desarrollo de este proyecto han aparecidos muchos problemas que con el
tiempo se han solucionado o se ha encontrado una manera de evitarlos.
Desafortunadamente también hay unos pocos problemas los cuales no se han podido
solucionar del todo. A continuacién se exponen los dos problemas con méas impacto y
las aproximaciones que se han intentado para solucionarlos.

Por un lado est4 el paso adicional en el refinamiento de la nube de puntos resultante
llamado Bundle Adjustment (BA). Como ya se ha explicado en el apartado de anélisis,
este proceso conlleva una gran mejora a los resultados obtenidos. El libro del cual se ha
obtenido el codigo del modulo de SfM [13] utiliza una libreria llamada SSBA (simple
sparse bundle adjuster) para este cometido. Dado que este proyecto esta escrito para
dispositivos méviles Android y la libreria mencionada esta escrita en C, no es trivial
utilizarla. Se intenté compilar la libreria utilizando el NDK de Android sin éxito.
Incluso se cred un post pidiendo ayuda en StackOverflow, una de las paginas mas
utilizadas en cuanto a dudas sobre desarrollo de software se refiere. El post se
encuentra en [16] y a dia de escribir esta memoria no cuenta con solucion.

También se intenté utilizar una herramienta llamada Ceres Solver. Esta libreria es
propiedad de Google y es capaz de realizar BA. Desgraciadamente después de mucho
investigar no se consiguié que funcionara en este proyecto, aunque si que se tiene
pensado centrarse en esta libreria para implementar el BA en la aplicacion en trabajos
futuros, ya que es una libreria la cual se puede compilar con relativa facilidad para el
sistema operativo Android.

El otro gran problema encontrado es que al incluir la libreria PCL la aplicacion ya no es
compilada para todas las arquitecturas de Android existentes. Por esta razon,
solamente se compila para arquitecturas ARMEABI-v7a. Aunque si que es cierto que es
la arquitectura mas utilizada, siempre se deberia intentar cubrir una compatibilidad
méas grande posible. Probando a compilar PCL para otras arquitecturas como por
ejemplo x86 o mips, siempre resultaba en un error como sigue:

Undefined reference to ‘'omp_get_max_threads_'

Esto se consigui6 solucionar implementando el parche [23] en el archivo
correspondiente, resultando en la compilacién correcta de la libreria para las diferentes
arquitecturas. Desafortunadamente seguian produciéndose muchos errores a la hora de
compilar la aplicacién con las librerias compiladas anteriormente, los cuales no se han
podido solucionar.
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6.2 Mejoras futuras

En este apartado se pretende proponer una serie de mejoras que por falta de tiempo o
conocimiento no se han podido implementar. Algunas de ellas son:

e Solucionar los errores expuestos en el apartado anterior.

e Mejorar la eficiencia de la aplicacién haciendo uso de todos los nucleos de
calculo disponibles mediante técnicas de computacién paralela.

e Mejorar la deteccidon de puntos clave para que la aplicacion sea mas robusta.

e Implementar la técnica de optical flow para calcular el movimiento de las
camaras.

e Afadir texturas al modelo final.

e Implementar una eliminacién manual para los puntos erréneos una vez
obtenida la nube de puntos.

e Permitir guardar el resultado en un formato de impresion 3D.

6.3 Conclusiones finales

Con el desarrollo de este proyecto se ha llegado a comprender mucho mejor la
complejidad que supone el desarrollo de un proyecto de software, asi como la
importancia de seguir una metodologia claramente especificada. Se ha observado la
gran importancia que posee el realizar adecuadamente una documentaciéon
previamente al proceso de desarrollo, ya que en una primera instancia, tras la
realizacidon de una investigacion previa, se empez6 la implementacion sin una perfecta
compresion de los conceptos y herramientas a utilizar. Lo cual produjo resultados
negativos, permitiendo la obtencién de un feedback que redirigi6 el proyecto siendo
necesario empezar de nuevo con nuevos conocimientos mas adecuados. Un vez el
proyecté se encauzdé a buen rumbo se desarrollo fluidamente hasta su completa
realizacion. Gracias a dicho feedback se ha adquirido una experiencia
considerablemente positiva para afrontar futuros proyectos de forma mucho méas
capacitada.

Ademas de esta valiosa leccion, se han aprendido numerosas habilidades, entre ellas la
utilizacion de uno de los sistemas operativos moviles mas utilizados, de los
fundamentos basicos de la vision por computador junto a la libreria mas importante en
este campo, asi como la creacion de graficos en 3D mediante OpenGL, finalmente cabe
remarcar el aprendizaje de la programaciéon en uno de los lenguajes mas importantes
como es C++.

A parte de todo lo aprendido expuesto anteriormente, cabe destacar que se esta
satisfecho por haber superado el reto de solucionar de una forma razonable este
problema de andlisis 3D, computacionalmente tan exigente, en un entorno limitado
como lo es un dispositivo movil. Las buenas capacidades de representacion grafica en
estos dispositivos han permitido obtener unos resultados muy vistosos, los cuales
pueden tener amplias utilidades de uso, como por ejemplo la impresiéon 3D o el uso en
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nuevos sistemas de entretenimiento como lo es la reciente realidad virtual. Cabe
mencionar que esto no es mas que un comienzo, ya que se pretende mejorar la
aplicacion solucionando los errores e implementando las mejoras mencionadas en los
puntos anteriores, llevando a publicar la aplicacién en un futuro en la tienda de Google
Play.

Por ultimo, es importante indicar que tras la realizacion de este proyecto se ha
entendido el valor de los conocimientos adquiridos en el grado siendo estos de gran
utilidad en cuanto a la preparacion del alumno a la hora de afrontar proyectos futuros.
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Anexo | - Manual de usuario

Una vez arrancada la aplicacion aparecera en el menu principal dos botones:

&[0 9
7ScanEye3D

@ % O 4 @ 1:56

\ UNIVERSITAT
/) POLITECNICA
DE VALENCIA

Take

pictures @
Load

pictures @

"V etsinf

El boton 1 se encarga de abrir la galeria del dispositivo para mostrar las imagenes
disponibles:

& o L] ® % 0“4 @ 1:57

= ScanEye3D ~

RSP .a A"
26 de ene. de 2016 26 de ene. de 2016

:Jﬁ R 5 }%

26 de ene, de 2016

Fo S h)

26 de ene. de 2016
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Para seleccionar multiples imagenes simplemente se tiene que mantener el dedo
pulsado sobre una imagen hasta que se active el modo de seleccion maltiple:

PR ® % 0“4 B 1:57

<  Seleccionado: 2 9 ABRIR

g
- Lo o SPLRTE

26 de ene. de 2016

Una vez seleccionadas las fotografias deseadas, se termina el proceso pulsando el boton
3.

Si en el mena principal se elige el boton 2, se abrira la vista de la camara en el
dispositivo, donde pulsando la pantalla se realiza una captura notificando al usuario de
ello:

3 images saved

Presionando sobre el boton 4, aparecera un pequefio ment, el cual permite cambiar la
resolucion de la cAmara o terminar la toma de iméagenes.
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Si se desea cambiar la resolucion de la cAmara, mediante el boton 6, aparecera una
ventana con las resoluciones disponibles:

Resolution

1920x1080

1600x1200

1280x960

1280x768

En caso de haber tomado ya alguna fotografia anteriormente con una resoluciéon
diferente, las imagenes son borradas ya que el algoritmo de SfM no esta preparado para
trabajar con resoluciones diferentes.

Deleted photos, please use same
resolution.
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Pulsando el botdn 5 se inicia el proceso de SfM mostrando una pantalla de carga.

& o L] ® % 10 4 B 1:59
ScanEye3D

LOADING

Una vez terminado se muestra la nube de puntos calculada, permitiendo al usuario
rotarla mediante movimientos del dedo por la pantalla. También se puede realizar
zoom, moviendo el dedo de derecha a izquierda en la parte superior marcada con el
ndmero 7.

® % 0“4 B 1:59
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En la parte inferior de la pantalla se muestra un pequefio menu con varias opciones, el
boton 8 inicia el proceso de filtrado de la nube de puntos, eliminando gran parte de los
puntos erroneos que pueden darse. Si antes de pulsar este botén no se ha configurado
el filtro mediante el boton 9, se ejecutara el filtro con los valores por defecto. Es
recomendable ajustar manualmente estos pardmetros para garantizar un resultado més
optimo. Los ajustes mostrados por el botén 9 son los siguientes:

@ % 04 & 1:59

Filter menu
Amount of neighbours used in %

> E——

Threshold used to be considered a good

Opcidn 11: Se refiere a la cantidad de puntos vecinos que se utilizan para realizar el
filtrado. Si se selecciona el maximo ntimero posible, se emplean todos los puntos de la
nube de puntos. Esto puede producir un aumento notable en el tiempo de computacion
del filtro, pero también puede ofrecer resultados mejores.

Opcion 12: Es el umbral con el que se decide si un punto es valido o no. Cuanto mas
bajo es, mas puntos se eliminan.

Pulsando el bot6on 13 se guardaran los ajustes y se volvera a la vista de la nube de
puntos.

También es posible saltarse por completo el paso de filtrado pulsando el botén 10. Una
vez ejecutado el filtro se mostrara la nube de puntos filtrada.
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® % v ‘4 @ 2:00

Si no se esta contento con el resultado, se puede volver al paso anterior mediante el
boto6n 16 y realizar un reajuste del filtro. Los otros botones tienen un comportamiento
similar a los del paso anterior. El boton 15 mostrara la configuracion de los ajustes para
la reconstruccion, y el boton 14 inicializara el proceso. Pulsando 15 apareceran los
siguientes ajustes:

' ® % 0 ‘4 & 2:00
ScanEye3D

Surface reconstruction menu
Normal search radius

+ R

Poisson depth

o PR

Poisson samples per node
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Opcion 17: El radio que se aplica para calcular la normal de un punto. Todos los puntos
dentro de este radio seran tenidos en cuenta en el calculo.

Opcion 18: Maxima profundidad del 4rbol que sera utilizado para la reconstruccion.

Opcion 19: Minimo nimero de puntos de muestra que deberia haber en un nodo octree.
Para modelos con poco ruido se recomiendan valores entre 1y 5, mientras que para
modelos con ruido valores mas altos son recomendados.

Pulsando 20 se guarda la configuracion y se vuelve a mostrar la nube de puntos.

Una vez realizada la reconstruccion se mostrara el modelo calculado. Si no se esta
satisfecho con el resultado se puede volver con el boton 22. Para guardar el modelo
solamente hay que pulsar el botén 21.

® % 0 ‘g @ 2:01
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Anexo Il - Instalacion y configuracion

En este apartado se va a explicar la instalacion y configuracion del entorno de
desarrollo utilizado en este proyecto. Dado que se utilizan varias herramientas puede
resultar complejo hacerlas funcionar en armonia, por lo que aqui se resume como se ha
conseguido esto. Los pasos aqui mostrados corresponden al sistema operativo OSX en
su version 10.11 El Capitan.

1. Configuracion de Eclipse para Android

Ol 166 ME 670,262 DOWNLOADS Mac 05X
( h.-'-]?

ke

h—4 The essential tools for any Java developer, including a Java IDE,
a Git client, XML Editar, Mylyn, Maven integration and
WindowBuilder...

En primer lugar hay que descargar el entorno IDE, en este caso Eclipse. Para esto hay
que dirigirse a [2] y seleccionar el sistema operativo correspondiente. A continuacion se
procede a descargar la version de Eclipse para Java.

Esto descargara un archivo comprimido, el cual hay que descomprimir para
encontrarse con el lanzador de Eclipse.

GHEEF

eclipse-java-
mars-2-...x86_64.tar Eclipse

7€

A continuacion es necesario descargar el SKD de Android, el cual se puede encontrar en
[1] en la seccion “Get just the command line tools”. Al presionar el boton de descarga
aparecera una pantalla indicando los términos de uso.

Download the Android SDK Tools

Terms and Conditions
This is the Android Software Development Kit License Agreement
1. Introduction

1.1 The An rred 10 in the License

the Androl

n files, pa A aogle APIs add-ons)

e Agreement. The License Agreement forms a legally binding contract between you and Gaogle in relation to

your use of the SDK.
1.2 "Android” means the Android software stack fos ailable under the Android Open Source Project,
which is located at the following URL: http:/source.andr ated from time to time

I have read and agree with the above terms and conditions
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Una vez descargado el SDK, aparecera una carpeta en nuestro ordenador. Esta carpeta
hay que guardarla en una ubicacién adecuada ya que contiene todo lo necesario para el
desarrollo en Android. En este caso se ha creado una ubicacién especifica para
almacenar todos los ficheros relacionados con el proyecto.

android-sdk-

macosx
4 items

El siguiente paso es abrir Eclipse y seleccionar el workspace, o lo que es lo mismo, el
sitio donde se quiera guardar los proyectos realizados con Eclipse. Una vez se ha
desplegado la interfaz, hay que dirigirse en el mena hasta

Help > Install New Software

En la siguiente ventana hay que presionar el boton “Add” en la esquina superior
derecha y rellenar los campos como se muestran a continuacion:

@ Edit Site

Name: ADT Plugin

Location:  https://dl-ssl.google.com/android/eclipse/

? Cancel —

Después de instalar el plugin y reiniciar Eclipse hay que indicarle donde se encuentra el
SDK bajado anteriormente. Esto se consigue bajo

Eclipse > Preferencias > Android > SDK Location|
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| ® o Preferences
Android v v w |
» General -
U
: gr;é SDK Location: /Users/rubenruoff/Android/android-sdk-macosx Browse...
++
» Code Recommenders Note: The list of SDK Targets below is only reloaded once you hit 'Apply’ or ‘OK".
» Help
» Install/Update Target Name Vendor Platform API Lev:
» Java Android 4.3.1 Android Open Source Project 4.3.1 18
» Maven Android 5.0.1 Android Open Source Project 5.0.1 21
» Mylyn Android 6.0 Android Open Source Project 6.0 23
» Oomph Google APIs Google Inc. 6.0 23
» Run/Debug
» Team
Validation
» WindowBuilder
» XML
Restore Defaults Apply
@ @ cancel (TSN

Aparecera una ventana indicando que faltan componentes por instalar, lo cual se puede
hacer abriendo el SDK Manager pulsando el boton que nos muestra. También se puede
acceder mediante el ment seleccionando

Window > Android SDK Manager

Seleccionando la API que se quiera usar junto a las herramientas de plataforma y
construccion, se procede a instalarlos.

%' Name API Rev. Status
¥ | Tools

-+~ Android SDK Tools 24.4.1 5 Update available: rev. 25.1.
+" Android SDK Platform-tools 23.1 Not installed
/" Android SDK Build-tools 23.0.3 Not installed

" Android SDK Build-tools 23.0.2 Not installed

" Android SDK Build-tools 23.0.1 Not installed

/" Android SDK Build-tools 22.0.1 __ Not installed

¥ Android SDK Build-tools 21.1.2 | Not installed

/" Android SDK Build-tools 20 Not installed

. 4 Apdroid ASDK Euild—gools 19.1 Not installed

¥ [2 Android 5.0.1 (APl 21)
'R SDK Platform 21 2 Not installed
¥ Android TV ARM EABI v7a Svstem Imaae 21 3 Not installed
"% Android TV Intel x86 Atom Svstem Imaae 21 3 Not installed
¥ Android Wear ARM EABI v7a Svstem Imaae 21 3 Not installed
¥ Android Wear Intel x86 Atom Svstem Imaae 21 3 Not installed
"% ARM EABI v7a Svstem Imaae 21 3 Not installed
"¥ Intel x86 4 Android SDK Platform 5.0.2 21 3 Not installed
¥ Intel x86 4 Revision 3 21 3 Not installed
¥ Gooale Al Requires SDK Platform Android APl 21 21 10 Not installed
i Gooale Al Size: 177,9 MiB 21 10 Not installed
¥ Gooale Al Provided by dl.google.com 21 10 Not installed
' Gooale APIs 21 1 Not installed
L) Sources for Android SDK 21 1 Not installed
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[ NON ) Choose Packages to Install

Packages Package Description & License
Packages
+" Android SDK Tools, revision 25.1.1 - Android SDK Tools, revision 25.1.1
+" Android SDK Platform-tools, revisi - Android SDK Platform-tools, revision 23.1
+ Android SDK Build-tools, revision - Android SDK Build-tools, revision 23.0.3
+ SDK Platform Android 5.0.1, AP| 2 - SDK P_Iatform Android 5.0.1, API 21, revision 2 )
+ Android TV ARM EABI v7a System ;ee?s?‘;zlc; TV ARM EABI v7a System Image, Android API 21,

£

Android Support Library, revision | - Android Support Library, revision 23.2.1

License
Terms and Conditions

This is the Android Software Development Kit License
Agreement

1. Introduction

Copy to clipboard | Print o Accept License

[*] Something depends on this package Cancel -ﬂﬁﬂ-

Terminado este proceso ya est4 correctamente instalado y configurado el SDK de
Android.

Ahora se puede crear un proyecto Android yendo a:

File > New > Project

Aqui hay que desplegar la opciéon “Android” y seleccionar “Android Application”
Project. En la siguiente ventana hay que introducir en nombre de la aplicacion asi como
la version del SDK con la que se quiere trabajar. La opcion ”Minimum Required SDK”
indica la version mas baja soportada por la aplicacion, esta opcion es interesante para
dar un mayor soporte a dispositivos mas viejos. Se avanza creando una actividad en
blanco y pulsando sobre el boton “Finish”. Eclipse creara todos los archivos necesarios
y mostrara en el “Package Explorer” el contenido del proyecto.
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[ NON ] New Android Application
New Android Application

Configure Project

Create custom launcher icon

Create activity

Mark this project as a library

Create Project in Workspace

Location:

Working sets

| Add project to working sets

Working sets: <

@ < Back Cancel

® ( } New Android Application

New Android Application

(1, The prefix ‘com.example.’ is meant as a placeholder and should not be used

Application Name: & Test
Project Name: B Test

ge Name: * com test

Minimum Required SDK: AP| 8: Android 2.2 (Froyo)

Compile With:

a

Target SDK: 8 API 21: Android 4.X (L Preview)
B APl 21: Android 4.X (L Preview)
a

Theme: Holo Light with Dark Action Bar

(R oROR

The application name is shown in the Play Store, as well as in the M. Application list in

]

@ < Back Cancel
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[ ] [ ] New Android Application

Create Activity

Select whether to create an activity, and if so, what kind of activity. e

Create Activity

Blank Activity |
Blank Activity with Fragment

Empty Activity

Fullscreen Activity

==
Master/Detail Flow

Navigation Drawer Activity
Tabbed Activity

Blank Activity
Creates a new blank activity with an action bar.

.
| @ < Back cancel

[ ] @ New Android Application

Blank Activity

Creates a new blank activity with an action bar. e

Activity Name B MainActivity

Layout Name 8 activity_main

., The name of the activity class to create

|
@ < Back Cancel

Cabe destacar que la version de Android SDK Tools y la version de Project Build Target

tienen que ser las mismas, si no, se produce uno o varios errores como el que se
muestra a continuacion:

No resource found that matches the given name 'android:Widget.Material.Button.Colored'
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2. Anadir OpenCV para Android a Eclipse

El siguiente paso es afiadir OpenCV al proyecto Android creado anteriormente. Para
ello hay que dirigirse a [3] y descargar la version “OpenCV for Android”.

2015-12-21
VERSION 3.1

=@ OpenCV for Windows

™ OpenCV for Linux/Mac

.‘i. OpenCV for Android

& OpenCV foriOS

Una vez descargado, apareceré la carpeta correspondiente en nuestro ordenador, la
cual habra que guardar en una ubicacion facil de localizar.

Nombre
> apk
LICENSE
README.android
> samples
> sdk

Para incluir esta libreria en Eclipse, hay que dirigirse a:

File > Import > General > Existing Project into Workspace

En la opcion “Select root directory” hay que indicar la ubicacion de la carpeta
descargada anteriormente. Al pulsar el boton abrir aparecera junto a la libreria una
seria de ejemplos y tutoriales. Seleccionando solamente la libreria se pulsa el boton de
“Finish” y OpenCV seré anadido al entorno de desarrollo.

OpenCV Library - ¢
OpenCV Sample -
OpenCV Sample -
OpenCV Sample -
OpenCV Sample - -
OpenCV Sample -
OpenCV Tutorial 1
OpenCV Tutorial 2
OpenCV Tutorial 3

El altimo paso para afiadir OpenCV al proyecto es dirigirse a las propiedades del
proyecto. Para esto se presiona el botén secundario sobre el proyecto y seleccionando
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“Properties” en el menu que aparece. En esta ventana hay que centrarse en la secciéon
“Library”:

Library

s Library

Reference Project Add
+" ../Jappcompat_v7 appcompat_v7

Presionando el boton “Add...” y seleccionando la libreria OpenCV, esta se afiadira con
éxito al proyecto.

Library
| Is Library
Reference Project Add
+" ..Jappcompat_v7 appcompat_v7
+" ..[../../Downloads/Op... OpenCV Library - 3.1.0
.
e, b= —
% Package Explorer 5% == O

> (& appcompat_v7/

.-‘E' OpenCV Library - 3.1.0

v rl_@ Test
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3. Configurar el NDK y OpenCV nativo en Eclipse

El primer paso es descargarse el NDK de Android desde [4], al igual que con el SDK
aparecera unos términos que hay que aceptar para poder usar esta herramienta.

Download the Android NDK

Before installing the Android NDK, you must agree to the following terms and conditions.

Terms and Conditions

1. Introduction

from time to time.

This is the Android Software Development Kit License Agreement

1.1 The Android Software Development Kit (referred to in the License Agreement as the "SDK" and
specifically including the Android system files, packaged APls, and Google APIs add-ons) is
licensed to you subject to the terms of the License Agreement. The License Agreement forms a

legally binding contract between you and Google in relation to your use of the SDK.

1.2 "Android" means the Android software stack for devices, as made available under the Android

Open Source Project, which is located at the following URL: http://source.android.com/, as updated

| have read and agree with the above terms and conditions

DOWNLOAD ANDROID-NDK-R11C-DARWIN-X86_64.ZIP

Una vez aceptado estos términos y descargado el archivo, habra que guardar la carpeta

creada en una ubicacion accesible.

Nombre

>

4
>

build
CHANGELOG.md

@ ndk-build

Bl ndk-depends

@ ndk-gdb

@ ndk-stack

[l ndk-which
platforms
prebuilt
python-packages

source.properties
sources
toolchains

Antes de empezar a construir la parte nativa, hay que crear la estructura de directorios
correspondiente. Para ello hay que crear una carpeta llamada “jni” en la raiz del
proyecto. Dentro hay que crear dos archivos, “Android.mk” y “Application.mk”.
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» [ appcompat v7
» (<l OpenCV Library - 3.1.0
v Test
> B src
» 8 gen [Generated Java Files]
» @\ Android 6.0
» m\, Android Private Libraries
» m, Android Dependencies
- assets
» (= bin
¥ &ini
& Android.mk
@ Application.mk
L€ jni.cpp
» 2 libs
» (= obj
> res
1 AndroidManifest.xm|
1 lint.xml
|| proguard-project.txt
project.properties

El primero de estos es el encargado de compilar codigo fuente C++ mientras que el
segundo suele ser opcional, pero aporta ciertas funcionalidades bastante ttiles. A
continuacién se muestra un ejemplo muy simple de cada archivo:

Android.mk
] LOCAL_PATH := $(call my-dir)
2include $CCLEAR_VARS)
_'-LOCQI__MODUI_E test

6 LOCAL_SRC_FILES := jni.cpp
"LOCAL_LDLIBS += -1log -1ldl

s include $(BUILD_SHARED_LIBRARY)

Application.mk

| APP_STL := gnustl_static
2 APP_CPPFLAGS := -frtti -fexceptions
1 APP_ABI := armeabi-v7a

Las dos primeras lineas del archivo Android.mk son obligatorias. La linea cinco indica
el nombre que tendra el modulo, lo cual es necesario saber para poder llamarlo desde la
parte Java. Linea seis indica todos los archivos que tienen que ser compilados para este
modulo. Finalmente con la linea nueve se crea una libreria conteniendo el m6dulo
especificado anteriormente.

La parte mas importante de Application.mk es la linea 3, donde se especifica la
arquitectura para la cual se quiera compilar. Lo mas recomendable es poner esta opcion
a “all’ para aumentar la compatibilidad de la aplicacion.

Para que el NDK funcione y se pueda establecer una comunicacion entre Java y C++,
hay que llamar al médulo compilado mediante el Android.mk y definir la funcion nativa
en la parte de Java:
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static {
System. loadLibrary("test");

}

public native int testNDK(Q);

En la parte C++, hay que declarar el origen de donde es llamada de la siguiente forma:

extern "C" {
JNIEXPORT iint INICALL, Java_com_example_test_MainActivity_testNDK(JNIEny. *env, jobiject.obid;

JNIEXPORT iint JNICALL Java_com_example_test_MainActivity_testNDK(JNIEny, *env, jobject. obj) {

int conv;

iipt retval;

conv

=1;
retVal =

Ciintdconv;

return retVal;

En este ejemplo, lo Gnico que se hace es devolver un nimero entero a la parte Java.
Como se puede observar, Eclipse indica que hay muchos errores de sintaxis aunque
realmente este bien. Para remediar esto hace falta configuracién adicional, por lo que
hay que dirigirse a:

Properties > C/C++ General > Paths and Symbols

e incluir lo siguiente:

Languages Include directories
Assembly ;.;L' ${NDKROOT}/platforms/android-9/arch-arm/usr/include
GNU C ..5 ${NDKROOT}/sources/cxx-stl/gnu-libstdc++/4.9/include
& ${NDKROOT)}/sources/cxx-stl/gnu-libstdc++/4.9/libs/armeabi-v7a/include

(1= /JUsers/rubenruoff/Downloads/OpenCV-android-sdk/sdk/native/jnifinclude

Cabe destacar que dependiendo de la version de NDK que se utilice, cambian las
versiones a incluir, por lo que es recomendable asegurarse antes de que version se
disponga. Una vez hecho esto, los errores de sintaxis habran desaparecido.

Para poder utilizar la libreria OpenCV nativa, basta con incluir el archivo OpenCV.mk
en el archivo Android.mk:
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LOCAL_PATH := $(Ccall my-dir)

include $(CLEAR_VARS)
include /Users/rubenruoff/Downloads/OpenCV-android-sdk/sdk/native/jni/0OpenCV.mk

LOCAL_MODULE test
LOCAL_SRC_FILES := jni.cpp
LOCAL_LDLIBS += -1llog -1dl

include $(BUILD_SHARED_LIBRARY)

Para construir la parte nativa, lo mas recomendado es utilizar el CDT Builder integrado
en Eclipse con el ADT Plugin. Antes que nada, hay que definir la variable ’NDKROOT*
como variable de entorno. En OSX esto se realiza afiadiendo la siguiente linea al
archivo “~/.bash_profile” :

export NDKROOT=/ubicacion/del/NDK

También es posible establecer esta variable dentro del de Eclipse, pero sera necesario
realizar para cada nuevo “workspace”. Para ello hay que dirigirse a:

Eclipse > Preferences > C/C++ > Build > Enviornment > Add...

o New variable
‘ Name: NDKROOT
! Value: /Users/rubenruoff/Android/android-ndk-r8b Variables

. Cancel [ OK

Después de realizar esto, es necesario reiniciar Eclipse para que los cambios sean
aplicados.

El siguiente paso es aplicar naturaleza C/C++ al proyecto. Esto se consigue dirigiéndose
a:

New > Other > C/C++ > Convert to a C/C++ Project

La ventana que aparece hay que configurarla como sigue:
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® ® Convert to a C/C++ Project

Convert to a C/C++ project Gl

The wizard adds C/C++ Nature to the selected projects to enable C/C++ Tools -
Support for them. It also converts old-style C/C++ projects to the new style.

Candidates for conversion:

l=> appcompat_v7 Select All

=> OpenCYV Library - 3.1.0
= Test

Convert to C or C++
C Project ° C++ Project
Project options

Specify project type

Project type: Toolchains:
(= Executable -- Other Toolchain --
(= Shared Library Android GCC
(== Static Library MacOSX GCC

(-~ Makefile project

Show project types and toolchains only if they are supported on the platform

@ < Back cancel | (GIEIES

Una vez haya terminado el proceso, hay que dirigirse a las propiedades del proyecto y
bajo “C/C++ Build” hay que deseleccionar la opcion “Use default build command” y
cambiar el comando de construccion de “make” a “6{NDKROOT}/ndk-build”, como se
nuestra a continuacion:

e Properties for Test

C/C++ Build Cav S o
» Resource
Android
Android Lint Confi { Default [ Active ] <] Manage Configurations...
Builders
¥ C/C++ Build
Build Variables
Environment & Bohavior . Refresh Policy
Logging =
Settings Builder
Tool Chain Editor
» C[C++ General Builder type: External builder 2
Java Build Path
» Java Code Style Use default build command
» Java Compiler 5 = ‘
» Java Editor Build command: | ${NDKROOT}/ndk-build Variables...
Javadoc Location
Project References Makefile generation
Run/Debug Settings
» Task Repository v
Task Tags

» Validation Build location
WikiText

Build directory:  ${workspace_loc:/Test}/

Workspace... File system... Variables...
Restore Defaults Apply
|\') Cancel OK

Bajo la pestana “Behavior” en la secciéon “Workbench Build Behavior” hay que
modificar los parametros como sigue:



® Properties for Test

C/C++ Build = "
» Resource
Android
Android Lint Preferences Configuration:  Default [ Active ] | T} Manage Configurations...
Builders
¥ C/C++ Build
Build Variables
Environment =] Builder Settings [l V(@ . Refresh Policy
Logging = . =
Settings Build settings
Tool Chain Editor

P C/C++ General Stop on first build error Enable parallel build
Java Build Path .

b Java Code Style

» Java Compiler

» Java Editor
Javadoc Location

Project References Workbench Build Behavior

Run/Debug Settings
» Task Repository Workbench build type: Make build target:

Task Tags Build on resource save (Auto build) Varlables...
P Validation

WikiText Note: See Workbench automatic build preference

Build (Incremental build) Variables...
Clean
Restore Defaults Apply
? Cancel | ok |

Al presionar el boton “OK” el “ndk-build” seréa invocado y construira el proyecto,
indicando un mensaje como el siguiente si todo ha salido segun lo previsto:

CDT Build Console [Test]

13:55:04 **** Auto Build of configuration Default for project Test ****
/Users/rubenruoff/Android/android-ndk-r8b/ndk-build

Compile++ thumb : test <= jni.cpp

In file included from jni/jni.cpp:1:0:
/Users/rubenruoff/Android/android-ndk-r8b/platforms/android-14/arch-arm/usr/include/jni.h:592:13
SharedLibrary : libtest.so

Install : libtest.so => libs/armeabi-v7a/libtest.so

13:55:04 Build Finished (took 279ms)

4. Compilar y afiadir la libreria de PCL

Para la compilacion de esta libreria se ha empleado un script obtenido de [6]. El primer
paso es declarar la variable de entorno ANDROID_NDK indicando la ubicacién del
NDK de Android. Una vez hecho esto, hay que crear una carpeta donde se quiera
guardar la libreria, navegar hacia ella con la terminal de OSX e introducir lo siguiente:

git clone https://github.com/hirotakaster/pcl-superbuild.git

Esto descargara todo lo necesario para proceder con la compilacion de la libreria. A
continuacion hay que dirigirse a la carpeta “pcl-superbuild” y crear una nueva carpeta
llamada “build”:

cd pcl-superbuild && mkdir build && cd build

Ahora ya se puede proceder a preparar los archivos para su posterior compilaciéon con:

cmake ../
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El Gltimo comando se encargara de descargar y compilar todas las dependencias de la
libreria:

make —j4

Una vez terminado esto, ya estaran compilados los archivos necesarios para incluir PCL
en Android. Para anadir estos archivos al entorno de desarrollo hay que dirigirse
primeramente desde la misma carpeta “build” a:

CMakeExternals > Install > pcl-android > lib

Aqui hay que seleccionar todos los modulos de la libreria que sean necesarios,
copiandolos a la carpeta “libs” en el proyecto de Eclipse.

> 2 appcompat_v7
B ‘!9 OpenCV Library - 3.1.0
Vv I Test
» B src
» Lj" gen [Generated Java Files]
» m, Android 6.0
» =, Android Private Libraries
» =, Android Dependencies
- assets
» = bin
» = jni
v = libs
[~ armeabi
lo14 libpcl_common.a
lo14 libpcl_filters.a
|o14 libpcl_io.a
lo1§ libpcl_surface.a
o1 libtest.so
android-support-v4.jar
P (= obj
> =res
/1 AndroidManifest.xml
< lint.xml
|| proguard-project.txt
project.properties

Para indicarle a Eclipse que incluya estas librerias en la aplicaciéon hay que anadir un
par de lineas al archivo Android.mk. La siguiente ilustracion muestra como se afiade el
modulo comin de PCL localizado en la carpeta “libs/pcl” :

include $(CLEAR_VARS)

LOCAL_MODULE := libpclcommon

LOCAL_SRC_FILES := ../libs/pcl/libpcl_common.a
include $C(PREBUILT_STATIC_LIBRARY)

Al crear la libreria compartida que incluye a todas las librerias estaticas y el codigo
nativo, hay que indicar donde se encuentran las cabeceras de estas librerias:

LOCAL_C_INCLUDES += /Users/rubenruoff/Android/pcl-superbuild/build/CMakeExternals/Install/pcl-android/include/pcl-1.6/
LOCAL_C_INCLUDES += /Users/rubenruoff/Android/pcl-superbuild/build/CMakeExternals/Install/eigen/

LOCAL_C_INCLUDES += /Users/rubenruoff/Android/pcl-superbuild/build/CMakeExternals/Install/boost-android/include
LOCAL_C_INCLUDES += /Users/rubenruoff/Android/pcl-superbuild/build/CMakeExternals/Install/flann-android/include

También hay que indicar las librerias estaticas que se desean incluir:
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LOCAL_STATIC_LIBRARIES :=

Con esto ya se puede utilizar la libreria en Android, para minimizar el tamafo del
ejecutable solamente se han empleado los médulos necesarios, por lo que si se desea
ampliar la aplicaciéon e implementar una funcionalidad que no esté disponible en los
modulos seleccionados habra que afiadir el/los médulo/s necesario/s.

libpclcommon libpclfilter libpclsearch Tlibpclkdtree libpclsurface libpclfeatures libpclio
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